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End-User License Agreement (EULA)

Use of this product is subject to the acceptance of our End User License Agreement, available here.

©2022 UVI. All rights reserved.
All trademarks are the property of their respective owners.

http://www.uvi.net/
https://www.uvi.net/en/end-user-license-agreement
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Introduction

CS-M 1.5
Analog Power-Synth, Revisited

CS-M 1.5 is including the full set of raw waveforms of the 01 

model, an expanded preset library with over 200 patches, and 

a massive boost to performance - delivering dramatically faster 

load times.

Between 1979 and 1984 one of our favorite Japanese 

manufacturers designed and built some of the most unique and 

distinct sounding analog synthesizers in the world. With CS-M 

we focused on some of the lesser-known models, including the 

70-M, 40-M, 20-M and 01.

UVI CS-M features a dual-layer architecture and instant 

preset/layer switching making it an extraordinarily responsive 

instrument capable of a wide and authentic sound palette. 

Layers include all possible base waveforms and noises as well 

as expertly programmed presets, all made on the original 

machines. In fact, great lengths were taken to ensure the 

authentic sound and natural character of these machines 

was preserved and translated clearly in CS-M. Everything was 

sampled, down to the unique unison and ensemble modes.

Enjoy the wonderful vintage sound of these synthesizers 

or take them into new territory with the UVI Engine. CS-M 

comes packed with a wealth of features to help you enrich 

and customize your sounds including double arpeggios, a step 

sequencer, LFOs and precision modeled FX - allowing you to 

freely tread in territory the old hardware couldn’t dream of.

From thick and gritty basslines to warm and bubbly arpeggios 

and sharp analog leads, UVI CS-M is a grand ode to some of our 

most beloved hardware inspirations. 

Minimum System Requirements

• Latest version of UVI Workstation or Falcon

• 1.35GB of disk space

For more information on the installation process, please refer to 

the document: Soundbank Installation Guide

http://www.uvi.net/
http://www.uvi.net/installing_uvi_soundbanks_en.pdf
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Edit Page

6Pitch

3Layer Globals

2Pages

5Layer Edit

7 Amplitude

8 Drive

1 Presets

4 Master Gain

The UI is divided into three pages; [Edit], [Mod] and [Arp]. Primary controls such as amp, filter, stereo, pitch and effects are available on the [Edit] page. 
Clicking the [Mod] button at the top of the interface reveals the second page of controls containing the LFO and Step Modulator. The final [Arp] page 
presents an independent arpeggiator for each layer.

Main

1  Presets
Select a global preset from the pull-

down menu or browse them with the 

Prev/Next arrows

2  Pages
Change the current page by selecting 

one of the 3 options; Edit, Mod or Arp

3  Layer Globals
» On/Off Toggle

» Volume

» Pan

» Octave [+1, 0, -1]

4  Master Gain
Set the Output Gain for the instrument

Basic Controls

5  Layer Edit
» Edit A | Edit B | Edit All

Choose to edit layers A or B seperately 

or simultaneously

» Wave Menu

Choose the wave category in the first 

row and the wave in the second

6  Pitch
» Tune

Adjust the pitch in Semitones/Cents

» Depth

Adjust the Portamento depth

» Mode

Toggle between Mono and Poly voicing

» Time

Set the Glide time

7  Amplitude
» No Velocity

Sets all incoming notes to max velocity

» Velocity > Attack

Modulates attack amount based on 

incoming note velocity. Low velocities 

result in long attacks; high velocities 

result in short attacks

» ADSR

Attack / Decay / Sustain / Release 

envelope for the Amplitude section

8  Drive
» Amount

Sets the amount of drive

http://www.uvi.net/
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Edit Page  [continued]

9Stereo

12Modwheel

10Filter

10 Filter (ADSR)

11 Effects

Basic Controls (continued)

9  Stereo
» Mode

Off / Alternate Pan / Unison

» Color

Shifts color based on adjacent samples

» Spread

Change the stereo width

» Detune

UNI Mode Only: setunes layers

10  Filter
» Filter Modes

Choose Filter mode; High Pass, Band 

Pass, Low Pass or OFF

» Cutoff Freq

Filter cutoff frequency

» Resonance

Adjust the resonance (Q) of the Filter

» EG Depth

Modifies the amount of ADSR envelope 

to be applied to the Filter

» Velocity

Adjust the Velocity > Filter sensistivity

» ADSR

Attack / Decay / Sustain / Release 

envelope for the Filter section

11  Effects
» Power/Amount

Choose from Phaser, Delay, and Reverb 

(additional controls available in the 

Effects page of UVIWS and MF)

12  Modwheel
» Power/Amount

Easily route your controllers Modwheel 

to control common parameters such as 

Vibrato, Tremolo and Filter Depth

http://www.uvi.net/
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Mod Page

1Sync

5Step Sequencer

6Seq Params

2Waveforms

3LFO Controls

4 LFO Mod Routing

7 Seq Mod Routing

LFO

1  Sync
Enable/Disable LFO sync to Host Tempo

2  Waveforms
Choose LFO waveform; Sine, Triangle, 

Square or Sample & Hold

3  LFO Controls
» Speed

Change the LFO Speed

» EG Depth

Adjusts the amount of Attack and Decay 

to be applied to the LFO

» Attack

Attack time for the Speed envelope

» Decay

Decay time for the Speed envelope

4  Mod Routing
Control the amounts of LFO modulation 

to be applied to various parameters 

including; Pitch, Drive, Volume and Filter

 

Step Modulator

5  Step Sequencer
Interactive editor for programming 

sequenced modulations; bar height 

equals mod amount

6  Seq Params
» Res

Change the sequencers step length

» Steps

Change the amount of steps for the 

sequencer to play

» Delay

Delay time to activate first step

» Rise

Time to activate step with a smooth 

transition

» Smooth

Interpolates values between adjacent 

steps to smooth parameter modulation 

for a custom LFO effect

7  Mod Routing
Control the amounts of modulation to be 

applied to various parameters including; 

Volume and Filter

http://www.uvi.net/
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Arp Page

1Step Indicator

3Tie

4Mode

5Arp On/Off

7Arp Mode

6Grid

2Step Editor

9 Steps

8 Gate

10 Octave

1  Step Indicator
LED lights up when step is triggered

2  Step Editor
16-step sequencer; affects Velocity

3  Tie
When active, step inherets Velocity from 

the previous step

4  Mode
Mono mode = Arpeggiator 1 affects both 

layer 1 and layer 2 

Stereo mode = each Arp modifies its 

corresponding layer (A=1, B=2)

5  Arp On/Off
Toggle the Arpeggiator On/Off

6  Grid
Change the step length

7  Arp Mode
Select Up, Down, or Up and Down

8  Gate
Change the step length (knob value 

ranges from zero to the tracks 

Resolution setting)

9  Steps
Sets the Arpeggiators step length

10  Octave
Set the pitch range of the Arpeggiator 

in Octaves

http://www.uvi.net/
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Presets

Arpeggios
AR-Art Peggios

AR-Barbarian

AR-Cool Session

AR-CS One Again 

AR-Diode Power

AR-Gumball Acrobatics

AR-Kieseritzky G

AR-Kitch Pop Corn

AR-Perfect G

AR-Play 3 Notes

AR-Primitive

AR-Spatial Story

AR-Tangerinoise

AR-Tanjarre Dream

AR-Tease Analog

AR-Xanalog Beat

AR-Xperimental Valley

Bells
BL-A Very Small One

BL-Baby Bell

BL-Bella Noisa

BL-Ego Bells

BL-Ensembells

BL-Genesis

BL-Guiz Mode

BL-Harpsybell

BL-Hi PWM

BL-James Bells

BL-One CS Bell

BL-Passage

BL-Satin

BL-Tremolos

BL-Very Analog

Brassy
BR-Dirty Crazy

BR-Eve Angelis

BR-French Horn Like

BR-GuiBRastar

BR-K Brass Orch

BR-Lazer Brass

BR-Majestic OBrass

BR-Power Brass

BR-Sea Fluid

Bass
BS-Alley Shakedown

BS-Baxtandal

BS-Burnt Popcorn

BS-Chinese Fretless

BS-Crate Duster

BS-Grain Bass Lead

BS-Greem B

BS-Intoxic

BS-Jo B Jo Bass

BS-L0c0m0t1v8r

BS-Magus Electrus

BS-Multi Polarity

BS-Music and Nights

BS-Obese

BS-One Note Line

BS-TB Progress

BS-TrenZ Diana

BS-Underground

BS-Way Sub

BS-Yeti Bass

BS-You and Bass

BS-Your Freek

BS-Zapp Nostalgia

Play Chords
CH-8bit Stew Fly

CH-Accelerator

CH-Analog Crunch

CH-Decade Inversion

CH-Evolu Chord Wheel

CH-Little Monster

CH-Mahyem Ragga

CH-Move On

CH-Nate FF1087

CH-Parallel Predators

CH-Relaxing Wheel

CH-Starlight

CH-Talking One

CH-U Di Paris

CH-Windax Boxer

FX / Drone
FX-Cochon in Space

FX-Dayvan Indian

FX-Droning

FX-Glissandi

FX-Haunted Flat

FX-Interstellar

FX-Kaufman Synchronus

FX-LoFi CoalRider

FX-Move Away

FX-Neptoms

FX-Noise Dunes

FX-Quasi Quasar

FX-Rue of Terra

FX-Sub Liminal

FX-Sweep Machine

FX-Talking Tex

FX-Tube Thanks

Keyboards
KB-CS Analog Piano 1

KB-CS Analog Piano 2

KB-CS Analog Piano 3

KB-Dirty Organ

KB-Dynogital

KB-Fantasiatic

KB-HarpsYanalog

KB-Key Tooma

KB-King Court

KB-Majestic Keys

KB-Majestic Organ

KB-Molecular

KB-Nick Wheel Organ

KB-Oldganic

KB-Orgalogic

KB-Organ 20M

KB-Pluck Road

KB-PMW Keys

KB-Prophet Tines

KB-Seq Clavistan

KB-Short Piano

KB-Soft Pluck

KB-Space Caroussel

KB-Synth Piano

KB-Troshrgan

KB-Vox Populi

Lead
LD-Cajolead

LD-Creamy Synth

LD-CS One Two 

LD-CSolo 70M

LD-CSweep Lead

LD-FeedbacKing

LD-First Lead

LD-Funky Cucumber

LD-Fusion Lead

LD-Green Show New

LD-Guitar Air HO

LD-Hernani

LD-Mono AL

LD-NoiSolo

LD-Screamer

LD-Seventh Dimension

LD-Short Cop X

LD-Slow Solo

LD-Strange LFO

LD-Very Short One

LD-Vocal Theremin

LD-Wha Wheel Solo

LD-Xtatic Motion

Noisy
NS-ColdnQuiet

NS-Guiznoiso

NS-Noise Melody

NS-Noisonic Pad

NS-Ominousea

Pads
PD-86 Skies Full Wheel

PD-Analog Pure

PD-ARP Ominous

PD-Beautypad

PD-Creamy Flutter

PD-Creative Wheel

PD-Dark Volute

PD-Du ALmosphere

PD-Geologic

PD-Granular Soft

PD-Hall of Grain

PD-Hornalog Pad

PD-Hybrid Choir

PD-Joy Arp

PD-Little Planet

PD-Morpho

PD-Network Reso

PD-Orchestranalog

PD-PortArpmento

PD-Step Walking

PD-Urban Bed

Polysynth
PL-Big Power One

PL-Busy Times

PL-CS One Saw Fee

PL-Full Ens Synth

PL-Laughing Factory

PL-Numericharp

PL-Poly Game

PL-PolyGrain

PL-Portamanteau

PL-Raining Pluck

PL-Stab Island

PL-Submarine Scream

PL-Tekno Idea

Strings
ST-Bi Spectral Strings

ST-Ensemble Machine

ST-In a Box

ST-Lina Star

ST-Mutronic Strings

ST-My Eminent

ST-Noisycato

ST-Pizzanalog

ST-Soloist

Sweep
SW-Classic Jarr

SW-CreaSweep

SW-Fidel

SW-Inverted

SW-Majestueux

SW-Moment of Clarity

SW-Monowheelist

SW-Mosquito

SW-Original Sweep

http://www.uvi.net/
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Raw Waves

Ensemble
CSweep 70M

Full Ensemble

Lina Strings 1

Lina Strings 2

Machine String

Softy Brassy

Raw Poly
Bright Pad

Elec Piano

French Hornalog

Grain Soft 1

Grain Soft 2

OBrass

Power Wave

Short Piano

Raw Solo
Bass Lead

CSolo 70M

Double Seq

Laser

Pluck

Power Grain

Seq Clav

Solo Soft

Unison
Bass Lead 1

Bass Lead 2

Dirty Organ

Orchestral Brass

Polyson

Power Uni

Resophonic

Soft Pad

Thing Long

Waves
Saw

Sine

Sine-Saw

Square PWM 1

Square PWM 2

Square PWM 3

Square-Saw PWM 1

Square-Saw PWM 2

Square-Saw-Sine PWM 1

Square-Saw-Sine PWM 2

Waves Noises
Noise BP Raw

Noise BP Reso

Noise Flat Raw

Noise Flat Reso 1

Noise Flat Reso 2

Noise HP Raw

Noise HP Reso

Noise Unison Raw

Noise Unison Reso 1

Noise Unison Reso 2

Sub Noise Unison

Waves Unison
Sine-Saw Uni

Sine-Square Uni

Square-Saw Uni

Square-Saw-Sine Uni

20M Sounds
Big One

Big Two

Fifth Avenue

Funky Bass

Gizmono

Lazer

Noisonic

Organic

Pianoise

PortHardmento

SeqOrgan

Technoid

20M Waves
Noise

Saw

Sine

Square PWM 0

Square PWM 2

Square PWM 4

Square PWM 6

Square PWM 8

Triangle

CS01 Waves
PWM 1

PWM 3

PWM 5

PWM 7

PWM 9

Saw

Square 1

Square 2

Triangle

WhiteNoise

http://www.uvi.net/
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Links

UVI

Home . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . uvi.net/ 

UVI Portal .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  uvi.net/uvi-portal 

Soundbank Installation Guide . . . . . . . . . . . . . . . . . . . . . . . . . . . . installing_uvi_soundbanks_en.pdf 

UVI Workstation User Guide . . . . . . . . . . . . . . . . . . . . . . . . . . . . . uviworkstation_user_guide_en.pdf 

Your Registered Product Serial Numbers and Download Links.  .  .  .  .  .  .  .  .  uvi.net/my-products 

FAQ . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . uvi.net/faq 

Tutorial and Demo Videos . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . youtube.com/

Support . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . uvi.net/contact-support 

iLok

Home . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . ilok.com/ 

iLok License Manager  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . ilok.com/ilm.html 

FAQ . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . ilok.com/supportfaq 

http://www.uvi.net/
http://www.uvi.net/
https://www.uvi.net/uvi-portal.html
http://www.uvi.net/installing_uvi_soundbanks_en.pdf
http://www.uvi.net/installing_uvi_soundbanks_en.pdf
http://www.uvi.net/dwl.php?p=doc-en
http://www.uvi.net/dwl.php?p=doc-en
http://www.uvi.net/my-products
http://www.uvi.net/faq
https://www.youtube.com/user/UVIofficial
http://www.uvi.net/contact-support
http://www.ilok.com/
https://www.ilok.com/#!license-manager
https://www.ilok.com/#!faq
https://www.ilok.com/#!faq
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